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Περίληψη 
Το φάσµα ραδιοσυχνοτήτων αποτελούσε ανέκαθεν ένα πολύ σηµαντικό οικονοµικό πόρο. Παρόλα αυτά 
διάφορες µελέτες έχουν αποδείξει ότι η χρησιµοποίησή του, δεν είναι βέλτιστη καθώς για µεγάλα χρονικά 
διαστήµατα, τµήµατα του παραµένουν ανενεργά. Εισάγεται έτσι µία νέα ιδέα ανάπτυξης δικτύων 
επικοινωνιών, τα γνωσιακά δίκτυα επικοινωνιών, τα οποία θα είναι σε θέση να αντιλαµβάνονται το 
περιβάλλον γύρω τους, να αλληλεπιδρούν µε αυτό και να διαθέτουν το φάσµα στους χρήστες ανάλογα µε τις 
ανάγκες τους. Η νέα αυτή τεχνολογία θα επιτρέπει οι διάφοροι χρήστες/συστήµατα να ανταγωνίζονται 
µεταξύ τους, για τα φασµατικά αυτά τµήµατα. Στα πλαίσια αυτά η πτυχιακή αυτή εργασία θα 
πραγµατοποιήσει µια πλατφόρµα cognitive radio δικτύων σε visual studio µε δυνατότητα εκτέλεσης 
πολλαπλών σεναρίων σε διαφορετικά radio access technologies καθώς και εκτέλεσης δηµοπρασιών για την 
εκχώρηση του διαθέσιµου φάσµατος. Η πλατφόρµα C.R. δίνει την δυνατότητα στον χρήστη να 
πραγµατοποιήσει µετρήσεις και να πάρει αποτελέσµατα που έχουν να κάνουν µε τον υπολογισµό της 
µέγιστης περιοχής κάλυψης των σταθµών µετάδοσης καθώς επίσης και το uplink load factor. Τέλος γίνεται  
παρουσίαση των υλοποιηµένων δικτύων σε γραφικό αποτελούµενο απο όλους τους users οι οποίοι 
συνδέονται στους basestations και τους εξυπηρετούν καλύτερα. 
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Abstract 
Spectrum has always been an important economic resource. Nevertheless several studies have demonstrated 
that the use, is not optimal as for long periods, the parts remain inactive. Document introduces a new idea of 
developing communication networks, cognitive networks, which is able to perceive the environment around 
them, interact with it and have the range to users depending on their needs. This new technology will allow 
different users/systems to compete for the spectral segments. Within this framework this thesis will work out 
a platform for cognitive radio networks in visual studio can run multiple scenarios on different radio access 
technologies and executing auctions for the allocation of the available spectrum. The platform C.R. enables 
the user to perform measurements and get results that have to do with the calculation of the maximum 
coverage area of transmitting stations as well as the uplink load factor. Finally we present the graphical 
materialized networks composed of all users who are connected to basestations and serve them better. 
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1.ΕΙΣΑΓΩΓΗ 

∆ιάφορες µελέτες έχουν αποδείξει ότι η χρησιµοποίησή του φάσµατος ραδιοσυχνοτήτων, δεν είναι η 
βέλτιστη καθώς για µεγάλα χρονικά διαστήµατα τµήµατα αυτού παραµένουν ανενεργά. Για αυτόν τον λόγο 
λοιπόν αναπτύχθηκε µια νέα ιδέα  δικτύων επικοινωνιών, τα γνωστικά δίκτυα επικοινωνιών, τα οποία είναι 
σε θέση να αντιλαµβάνονται το περιβάλλον γύρω τους, να αλληλεπιδρούν µε αυτό και να διαθέτουν το 
φάσµα στους χρήστες ανάλογα µε τις ανάγκες τους. Τα νέα αυτά ασύρµατα συστήµατα επικοινωνίας 
βελτιστοποιούν την απόδοση του δικτύου µε την χρήση µηχανισµών δυναµικής διαχείρισης φάσµατος 
ανάλογα µε τις εκάστοτε απαιτήσεις και περιορισµούς των τελικών χρηστών. Με αυτό τον τρόπο το 
διαθέσιµο φάσµα ασύρµατης επικοινωνίας αξιοποιείται αποτελεσµατικότερα.Η νέα αυτή τεχνολογία 
προµηνύει ότι οι διάφοροι χρήστες, θα ανταγωνίζονται µεταξύ τους, για τα φασµατικά τµήµατα. Επίσης 
ορίζονται σαφείς κανόνες για το πότε κάθε χρήστης έχει δικαίωµα να εκπέµψει. Ο µηχανισµός δηµοπρασίας 
θέτει τους κανόνες αυτούς οι οποίοι προστατεύουν τον ανταγωνισµό µεταξύ των χρηστών. Οι 
χρήστες(δευτερεύοντες χρήστες) εισέρχονται σε µια διαδικασία δηµοπρασίας όπου πλειοδοτούν για τα 
φασµατικά τµήµατα και καταθέτουν τις προσφορές τους στον πωλητή(πρωτεύον χρήστης). Ανάλογα µε το 
είδος της δηµοπρασίας ο πωλητής καθορίζει τους νικητές, και τους κανόνες βάσει των οποίων αυτοί πρέπει 
να εκπέµψουν.Στα επόµενα κεφάλαια θα αναπτυχθούν διάφορες ένοιες σχετιζόµενες µε την τεχνολογία των 
cognitive radio όπως είναι  spectrum allocation, spectrum auctions και white spaces ή λευκά διαστήµατα τα 
οποία χαρακτηρίζουν το αχρησιµοποίητο ραδιοφάσµα. Επίσης θα γίνει αναφορά στην αναγκαιότητα για 
καλύτερη εκµετάλευση του αχρησιµοποίητου ραδιοφασµατος, η οποία προκύπει από την όλο και 
αυξανόµενη χρήση των ασύρµατων δικτύων. 

1.1 Αντικείµενο εργασίας 

Σκοπός αυτής της πτυχιακής εργασίας είναι η αξιοποίηση των χαρακτηριστικών των γνωσιακών δικτύων µε 
στόχο την βέλτιστη αξιοποίηση του διαθέσιµου ραδιοφάσµατος. Στα πλαίσια αυτής, µελετήθηκε η 
τεχνολογία cognitive radio, οι αλγόριθµοι δηµοπρασίας φάσµατος για την βέλτιστη διαχείριση των λεύκών 
περιοχών και τέλος υλοποιήθηκε πλατφόρµα CR δικτύων. 

1.2 ∆ιάρθρωση εργασίας  
Στην πτυχιακή εργασία αυτή, στο πρώτο κεφάλαιο γίνεται µία αναφορά στις υφιστάµενες τεχνολογίες των 
δικτύων επικοινωνιών καθώς και στην εξέλιξή τους. Στο δεύτερο κεφάλαιο παρουσιάζεται η cognitive radio 
τεχνολογία µε τα χαρακτηριστικά της. Στο τρίτο κεφάλαιο γίνεται εκτενής αναφορά στις τεχνικές ανίχνευσης 
και διαµοιρασµου του φάσµατος και τέλος στο τέταρτο κεφάλαιο παρουσιάζεται ο προσοµοιωτής cognitive 
radio. 

1.3 Σηµερινό τοπίο των ασύρµατων επικοινωνιών   

Τα τελευταία χρόνια παρουσιάζεται µια έκρηξη των παραγόµενων πληροφοριών που συνοδεύεται και από  
την αναβάθµιση των προσφερόµενων υπηρεσιών. Ο τοµέας των ασύρµατων επικοινωνιών αποτελεί 
χαρακτηριστικό παράδειγµα αυτής της εξέλιξης. Σήµερα, ο τελικός χρήστης απολαµβάνει ελκυστικότερες 
υπηρεσίες φωνής και υπηρεσίες δεδοµένων, µε την προσθήκη χαρακτηριστικών όπως η επίγνωση θέσης, η 
επίγνωση προσωπικών προτιµήσεων και γενικότερα, η επίγνωση περιβάλλοντος χρήσης. Η  ανάπτυξη των 
προσφερόµενων υπηρεσιών όµως, δε θα ήταν δυνατή χωρίς την εξέλιξη των αντίστοιχων τεχνολογικών 
υποδοµών και συγκεκριµένα, των τεχνολογιών ραδιοπρόσβασης (Radio Access Technology - RAT). Οι 
κυριότερες τεχνολογίες πρόσβασης που συνυπάρχουν σήµερα, µε τρόπο συνεργατικό και ενίοτε 
ανταγωνιστικό, παρουσιάζονται αναλυτικά παρακάτω. 

1.3.1 Ασύρµατα τοπικά και µητροπολιτικά δίκτυα 
Στην κατηγορία αυτή ανήκουν τα ευρυζωνικά ασύρµατα, τοπικά και µητροπολιτικά δίκτυα. Με ρυθµούς 
µετάδοσης µέχρι 54 Mbps και πρόσφατα µέχρι 248 Mbps(πρότυπο IEEE 802.11) τα ασύρµατα τοπικά 
δίκτυα(Wireless Local Area Networks-WLANs) χρησιµοποιούνται ευρέως σε πανεπιστήµια, ξενοδοχεία 
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συνεδριακούς χώρους, αεροδρόµια κ.τ.λ. Το µεγαλύτερο µειονεκτηµά τους, αυτό της σχετικά µικρής ακτίνας 
κάλυψης που δεν ξεπερνά τα 250 µέτρα έρχονται να καλύψουν τα ασύρµατα µητροπολιτικά δίκτυα (Wireless 
Metropolitan Network -WLANs) ή όπως συχνά αναφέρονται τα δίκτυα WIMAX (Worldwide Interopability 
for Microwave Access). Τo πρωτόκολλo που χρησιµοποιείται για την λειτουργία των WLANs είναι το 
802.11. 

1.3.2 Κυψελωτά συστήµατα 2ης γεννιάς  

Το κύριο χαρακτηριστικό της δεύτερης γενιάς(2G) κινητών δικτύων επικοινωνιών είναι οτι χρησιµοποιεί 
ψηφιακή µετάδοση της κίνησης. Αυτή είναι και η βασική διαφορά µεταξύ των κινητών συστηµάτων πρώτης 
και δεύτερης γενιάς δηλαδή ο διαχωρισµός αναλογικού - ψηφιακού. Τα δίκτυα δεύτερης γενιάς έχουν 
αυξηµένες δυνατότητες σε σχέση µε αυτά της πρώτης γενιάς. Ένα κανάλι συχνοτήτων διαιρείται και µπορεί 
να χρησιµοποιηθεί από διαφορετικούς χρήστες. Επιπλέον χρησιµοποιούνται ιεραρχικές δοµές κυψελών, για 
την ακρίβεια η περιοχή κάλυψης διαιρείται σε macrocells(κυψέλες µεγάλης έκτασης), microcells(κυψέλες 
µικρής έκτασης) και picocells(κυψέλες περιορισµένης έκτασης κυρίως σε µεγάλα αστικά κέντρα), µε 
αποτέλεσµα την περαιτέρω αύξηση των δυνατοτήτων των δικτύων. 
Έχουν αναπτυχθεί τρία κύρια πρότυπα για τα κινητά δίκτυα δεύτερης γενιάς. Αυτά είναι το GSM(Global  
System for Mobile) communications, το D-AMPS(Digital AMPS) και το CDMA(Code Division Multiple 
Access) IS-95. Το GSM είναι µακράν το πιο επιτυχηµένο και διαδεδοµένο σύστηµα δεύτερης γενιάς. 
Ξεκίνησε ως ένα ευρωπαϊκό σύστηµα αλλά τελικά υιοθετήθηκε παγκοσµίως. Η µόνη ήπειρος στην οποία η 
διάδοση του GSM υστερεί είναι η αµερικανική. Το GSM χρησιµοποιεί τη ζώνη συχνοτήτων των 900 MHz. 
Όµως υπάρχουν και αρκετά παράγωγα τα οποία χρησιµοποιούν τις ζώνες των 1800 ή 1900 MHz. Ο 
βασικότερος λόγος ήταν η έλλειψη χωρητικότητας στη ζώνη των 900 MHz. Η ζώνες των 1800 ή 1900 MHz 
µπορούν να εξυπηρετήσουν πολύ µεγαλύτερο αριθµό χρηστών, κυρίως σε πυκνοκατοικηµένες περιοχές.  

 

1.3.3 Η Γενιά 2,5 ∆ικτύων 
Η ονοµασία 2.5G περιγράφει µε τον καλύτερο τρόπο τις αναβαθµίσεις που έγιναν στα κινητά δίκτυα 
δεύτερης γενιάς. Οι περισσότερες αναβαθµίσεις παρέχουν παρόµοιες δυνατότητες µε αυτές των κινητών 
δικτύων τρίτης γενιάς. Αν και τα όρια µεταξύ των κινητών δικτύων δεύτερης γενιάς και αυτών της γενιάς 2,5 
είναι δισδιάκριτα, υπάρχουν συγκεκριµένες τεχνολογίες οι οποίες χαρακτηρίζουν τη γενιά 2,5. Αυτές οι 
τεχνολογίες είναι η HSCSD(High-Speed Circuit-Switched Data), η GPRS(General Packet Radio Services) 
και η EDGE(Enhanced Data Rates for Global Evolution). Οι χαµηλοί ρυθµοί µετάδοσης που περιορίζονταν 
στα 9,6 Kbps αποτέλεσε το µεγαλύτερο πρόβληµα που παρουσιάστηκε στις αρχικές µορφές του GSM. 
Η λύση που προτάθηκε για την αντιµετώπιση του προβλήµατος ήταν η τεχνολογία HSCSD. Σύµφωνα µε 
αυτή την τεχνολογία ένας χρήστης µπορεί να χρησιµοποιεί περισσότερες από µία χρονοσχισµές(timeslots) 
για µία σύνδεση µεταφοράς δεδοµένων. Η υλοποίηση αυτής της τεχνολογίας είναι σχετικά απλή και φθηνή.   
Χρειάζεται να υλοποιηθεί επιπρόσθετο λογισµικό στα κέντρα καθώς και καινούριες φορητές συσκευές που 
θα υποστηρίζουν την τεχνολογία HSCSD. Το βασικότερο µειονέκτηµα ήταν η χρήση µεταγωγής 
κυκλώµατος επειδή ο τρόπος αυτός µεταγωγής είχε ως αποτέλεσµα τη κατασπατάληση πόρων του δικτύου 
αφού οι χρονοσχισµές δεσµεύονταν ακόµα και όταν η χωρητικότητά τους  υποχρησιµοποιούνταν.  
Η επόµενη λύση που προτάθηκε ήταν η τεχνολογία GPRS. Αυτήν η τεχνολογία επιτυγχάνει ρυθµούς 
µετάδοσης 115 Kbps ή και ακόµα µεγαλύτερους. Το σηµαντικότερο χαρακτηριστικό της τεχνολογίας GPRS  
είναι οτι χρησιµοποιεί τεχνολογία µεταγωγής πακέτων. ∆ηλαδή, δεσµεύει τους πόρους του δικτύου µόνο 
όταν υπάρχει ανάγκη για αποστολή και λήψη δεδοµένων. Η υλοποίηση του GPRS είναι σηµαντικά 
ακριβότερη από αυτή του HSCSD. Επίσης, το HSCSD συµπεριφέρεται µε αξιοσηµείωτη συνέπεια σε 
εφαρµογές πραγµατικού χρόνου σε αντίθεση µε το GPRS. Παρόλα αυτά, η τεχνολογία GPRS προσφέρει 
πολύ µεγαλύτερες δυνατότητες για την αποστολή δεδοµένων µέσω των κινητών δικτύων.  
Η τρίτη και τελευταία βελτίωση του GSM προκειµένου να εξελιχθεί σε ένα δίκτυο 2,5G είναι η EDGE. Η 
βασική ιδέα του EDGE είναι µία τεχνική διαµόρφωσης που ονοµάζεται 8-PSK(Eight-Phase Shift Keying). 
Αυτή η τεχνική επηρεάζει µόνο το λογισµικό των σταθµών βάσης και προσφέρει έως και τριπλάσιο ρυθµό 
µετάδοσης από το βασικό ρυθµό µετάδοσης του GSM. Επιπλέον, µπορεί να συνυπάρξει µε την τεχνική 
διαµόρφωσης GMSK(Gaussian Minimum Shift Keying) η οποία χρησιµοποιείται στη βασική µορφή του 
GSM.  
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1.3.4 Κυψελωτά συστήµατα 3ης γενιάς  
Η ανάγκη για παροχή υπηρεσιών σε αυξηµένους πληθυσµούς και µεγάλες γεωγραφικές περιοχές 
υπερκαλύφθηκε από το πέρασµα των κυψελωτών συστηµάτων 1ης γενιάς στα κυψελωτά συστήµατα 2ης 
γενιάς. Η δυνατότητα όµως υποστήριξης υπηρεσιών δεδοµένων, είναι περιορισµένη στα συστήµατα 2G. 
Αυτός είναι και ο λόγος που οδήγησε στην σχεδίαση των κυψελωτών δικτύων 3ης γενιάς που παρέχουν 
υπηρεσίες µε υψηλούς ρυθµούς µετάδοσης, ώστε να µεταδίδεται σε πραγµατικό χρόνο βίντεο υψηλής 
ποιότητας (live streaming) ή να παρέχεται πρόσβαση στο διαδίκτυο µε υψηλές ταχύτητες.  

Τα βασικά χαρακτηριστικά των 3G δικτύων είναι τα εξής:  
 
• Υποστήριξη εφαρµογών πολυµέσων και δυνατότητα πρόσβασης σε πληροφορίες και 

υπηρεσίες µε υψηλούς ρυθµούς µετάδοσης µέχρι και 2Mbps 
• Μεταβαλλόµενος ρυθµός µετάδοσης  
• Πολυπλεξία υπηρεσιών µε διαφορετικές απαιτήσεις ως προς την ποιότητα (φωνή, βίντεο, πακέτα 

δεδοµένων) στην ίδια σύνδεση 
• Συνύπαρξη 2ης και 3ης γενιάς συστηµάτων για βελτίωση της κάλυψης  
• Μεγάλη φασµατική απόδοση 
• Συνύπαρξη FDD (Frequency Division Duplex) και TDD (Time Division Duplex) συστηµάτων 

1.4 Περιβάλλον πέραν της 3ης γενιάς 

1.4.1 Εξέλιξη των 3G - HSPA  
Τελευταία γίνεται εισαγωγή µιας νέας τεχνολογίας, για τα δίκτυα τρίτης γενιάς, που ονοµάζεται HSPA (High 
Speed Packet Access). Με την HSPA, οι πάροχοι των δικτύων είναι πλέον σε θέση να παράσχουν  υπηρεσίες 
µεταγωγής πακέτων πολύ υψηλής ταχύτητας, όπως πρόσβαση στο διαδίκτυο µε πολύ υψηλούς ρυθµούς 
µετάδοσης, ανάκτηση ηλεκτρονικού ταχυδροµείου µε συνηµµένα αρχεία, πρόσβαση σε ασύρµατες 
υπηρεσίες ήχου και video, ανάκτηση εικόνων πολύ µεγάλης ανάλυσης, κλπ. To HSPA περιλαµβάνει τόσο 
την τεχνολογία HSDPA(High Speed Downlink Packet Access) όσο και την HSUPA(High Speed Uplink 
Packet Access). 

1.4.2 Συστήµατα Κινητών Επικοινωνιών 4ης Γενιάς(4G) 
Η σηµερινή βιοµηχανία τηλεπικοινωνιών αναπτύσσει ραγδαίως νέες εφαρµογές, οι οποίες συνδυάζουν 
υψηλούς ρυθµούς µετάδοσης και κινητικότητα. Εκτός από την εξέλιξη των συστηµάτων 3G είναι τα 
συστήµατα κινητών επικοινωνιών 4ης γενιάς (4G) που βασίζονται κατά κύριο λόγο στα συστήµατα 3G και 
στις αναπτυγµένες εκδοχές τους.  Όλα τα δίκτυα 4G είναι ετερογενή δίκτυα βασισµένα στο πρωτόκολλο IP 
και επιτρέπουν στους χρήστες να χρησιµοποιούν οποιοδήποτε σύστηµα, οποτεδήποτε και οπουδήποτε το 
επιθυµούν. Χρήστες που διαθέτουν ολοκληρωµένα τερµατικά µπορούν να χρησιµοποιούν ένα ευρύ φάσµα 
εφαρµογών που παρέχονται από ετερογενή ασύρµατα δίκτυα.  Τα δίκτυα 4G παρέχουν υπηρεσίες δεδοµένων 
και πολυµέσων. Για την υποστήριξη των εφαρµογών πολυµέσων, παρέχονται υπηρεσίες υψηλών ρυθµών 
µετάδοσης και µε καλή αξιοπιστία αλλά ταυτόχρονα επιδιώκεται χαµηλό κόστος µετάδοσης.  

Επίσης τα συστήµατα νέας γενιάς θα παρέχουν προσωποποιηµένες υπηρεσίες που θα καλύπτουν τις αναγκες 
του εκάστοτε χρήστη. Με την αύξηση της διείσδυσης των συστηµάτων 4G, χρήστες από διάφορες 
διάσπαρτες γεωγραφικές περιοχές, µε διαφορετικά αντικείµενα και οικονοµικές δυνατότητες θα 
χρησιµοποιούν τις σχετικές υπηρεσίες. Για την ικανοποίηση των διαφορετικών αυτών χρηστών οι πάροχοι 
υπηρεσιών πρέπει να σχεδιάσουν προσωπικές υπηρεσίες προσαρµοσµένες στους χρήστες.  
Τέλος, τα συστήµατα 4G θα παρέχουν υποδοµή για ολοκληρωµένες υπηρεσίες. Οι χρήστες θα µπορούν να 
χρησιµοποιούν συνδυαστικά πολλαπλές υπηρεσίες από διαφορετικούς παρόχους. 
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Για την εξέλιξη των  συστηµάτων  4G  πρέπει να αντιµετωπισθούν τα εξής θέµατα:  
 

• Χρήση τερµατικών πολλαπλών τρόπων λειτουργίας  
• Ανακάλυψη διατιθέµενων ασύρµατων συστηµάτων 
• Επιλογή ασύρµατου συστήµατος 
• Κινητικότητα τερµατικού 
• Υποδοµή δικτύου και υποστήριξη QoS 
• Ασφάλεια και απόρρητο 
• Πολλαπλοί πάροχοι και σύστηµα χρέωσης 

 
Σύµφωνα µε την ITU ένα πρότυπο επικοινωνίας για να θεωρείται  τεχνολογίας 4G θα πρέπει να πληρεί τα 
εξής χαρακτηριστικά: 
 

• Ρυθµοί µετάδοσης εώς 100Mbit/s(για δίκτυα ευρείας επικοινωνίας)  και 1Gbit/s (για τοπικά δίκτυα 
επικοινωνίας) 

• Κλιµακωτό εύρος ζώνης καναλιού 5 – 20 Mhz 
• ∆ιασύνδεση ετερογενών δικτύων  
• ∆υναµική κατανοµή των πόρων του δικτύου για την ταυτόχρονη υποστήριξη περισσότερων 

χρηστών  
• Οµαλά handovers µεταξύ ετερογενών δικτύων 
• ∆υνατότητα να προσφέρουν υψηλής ποιότητας υπηρεσίες για υποστήριξη πολυµέσων επόµενης 

γενιάς. 
 

 

 
 

Εικόνα 1.1  Εξελιξη δικτύων κινητων επικοινωνιων[1] 

 
1.5 Το φάσµα ραδιοσυχνοτήτων 
Στις µέρες µας το φάσµα ραδιοσυχνοτήτων είναι ένας σηµαντικός οικονοµικός πόρος. Το εύρος ζώνης του η 
καταλληλοτητά του για συγκεκριµένες υπηρεσίες και οι παρεµβολές απο την ραγδαία αύξηση της χρήσης 
των ασύρµατων δικτύων τα τελευταία χρόνια, είναι µερικά από τα χαρακτηριστικά του. Ο ορισµός του ως 
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πόρος έγκειται στη χρησιµοποίηση των συχνοτήτων του για µετάδοση και λήψη δεδοµένων και ειδικότερα 
την εξυπηρέτηση συγκεκριµένων υπηρεσιών, τη γεωγραφική περιοχή κάλυψης, καθώς και το χρονικό 
διάστηµα χρησιµοποίησής του. 
Οι τεχνολογίες που χρησιµοποιούν το φάσµα ραδιοσυχνοτήτων και οι υπηρεσίες που προσφέρουν είναι 
πολλές και σηµαντικές. Παραδείγµατα τέτοιων τεχνολογιών είναι η κινητή τηλεφωνία, το GPS, οι 
δορυφορικές επικοινωνίες, η αναλογική και ψηφιακή τηλεόραση και η ραδιοφωνία Wi-Fi. Στην εικόνα 1.2 
φαίνεται η διάθεση φασµατικών πόρων για διάφορες τεχνολογίες στις Ηνωµένες Πολιτείες της Αµερικής το 
έτος 2003. 

 
Εικόνα 1.2  ∆ιάθεση φασµατικών πόρων στις Η.Π.Α 

 
 
Τα όργανα τα οποία είναι υπεύθυνα για την διαχείριση του φασµατικού πόρου είναι τα εξής: 
 

• ∆ιεθνής Ένωση Τηλεπικοινωνιών (ITU) 
• Ευρωπαϊκό Ινστιτούτο Τηλεπικοινωνιακών Προτύπων (ETSI) 
• Ευρωπαϊκή ιάσκεψη Αρχών Ταχυδροµείων και Τηλεπικοινωνιών (CEPT) 
• Οι κατά τόπους ρυθµιστικές αρχές όπως η FCC στις ΗΠΑ, ΕΕΤΤ στηνΕλλάδα 

 
Οι στόχοι των παραπάνω οργάνων είναι: 
 

• Μεγιστοποίηση της αξίας που παράγεται από τη χρήση του φάσµατος 
• Μεγιστοποίηση της χρήσης του φάσµατος 
• Αποτροπή των παρεµβολών 
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Για την επίτευξη των στόχων αυτών το φάσµα ραδιοσυχνοτήτων έχει χωρισθεί σε τρείς κατηγορίες: 
 

• Αδειοδοτηµένες ζώνες για αποκλειστική χρήση από συγκεκριµένες υπηρεσίες 
• Αδειοδοτηµένες ζώνες για αποκλειστική χρήση 
• Μη αδειοδοτηµένες ζώνες µε κοινή χρήση 

 
Στη πρώτη κατηγορία ζωνών ανήκει ο παραδοσιακός τρόπος διάθεσης φάσµατος, όπου οι φασµατικές ζώνες 
χωρίζονται σε κανάλια, και αδειοδοτούνται σε χρήστες για συγκεκριµένες υπηρεσίες όπως η διάθεση 
φάσµατος στην αναλογική τηλεόραση.  
Στην δεύτερη κατηγορία ο δικαιούχος του φάσµατος µπορεί να εκπέµψει κατόπιν επιλογής ότι επιθυµεί και 
να προσφέρει όποια υπηρεσία θέλει, µε την προϋπόθεση ότι δεν θα παρεµβάλει στα γειτονικά κανάλια και 
ότι δεν θα παρεµποδίζει τις υπηρεσίες που προσφέρονται από γείτονες δικαιούχους.  
Στην τρίτη κατηγορία ανήκει το µη αδειοδοτηµένο φάσµα, δηλαδή οι φασµατικές ζώνες που είναι ελεύθερες 
για κάθε χρήστη. Τέτοιο παράδειγµα αποτελεί το 802.11b ή Wi-Fi που λειτουργεί στα 2,4GHz.  
Tα τελευταία χρόνια, η ραγδαία ανάπτυξη των ασύρµατων επικοινωνιών, η όλο και αυξανόµενη ανάγκη για  
υψηλότερους ρυθµούς µετάδοσης, αλλά και η υπερχρησιµοποίηση συγκεκριµένων φασµατικών ζωνών έχει 
οδηγήσει στη αύξηση ζήτησης εύρους ζώνης αλλά και στον ανταγωνισµό µεταξύ φορέων για την κατοχή 
φάσµατος. Το πρόβληµα που φαίνεται να ανακύπτει είναι η πιθανή µελλοντική εξάντλησή του.  
Παρόλα αυτά µελέτες που έχουν γίνει στο φάσµα ραδιοσυχνοτήτων από τα 400ΜHz έως τα 1000MHz 
δείχνουν ότι αν και η φασµατική αυτή περιοχή είναι αδειοδοτηµένη, η αξιοποίησή της δεν είναι η βέλτιστη 
δυνατή. Το φαινόµενο αυτό λοιπόν ονοµάζεται white spaces ή λευκά διαστήµατα.  
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2. COGNITIVE RADIO NETWORKS 

2.1 Κίνητρα ανάπτυξης 
Τα δίκτυα των υπολογιστών βοήθησαν πολύ στην απόκτηση περαιτέρω γνώσεων και κάλυψαν τις ανάγκες 
του κόσµου. Βέβαια αυτό είχε σαν αποτέλεσµα την αλλαγή των απαιτήσεων των ανθρώπων για πιο πολλές 
πληροφορίες, που µε τη σειρά του οδηγεί στην προσπάθεια για βελτίωση των παρεχόµενων υπηρεσιών από 
τα τηλεπικοινωνιακά δίκτυα. Σήµερα γίνονται προσπάθειες για τη δηµιουργία και χρήση πολλών ετερογενών 
δικτύων, ώστε να υπάρξει βελτίωση των υπηρεσιών και της παρεχόµενης ποιότητας. Μια µορφή τρόπου 
δικτύωσης που φαίνεται να καλύπτει τις υπάρχουσες αλλά και µελλοντικές απαιτήσεις, αποτελούν τα 
«γνωστικά δίκτυα»(cognitive networks).  

2.2 Ορισµός 
Το γνωστικό δίκτυο επικοινωνιών, είναι ένα έξυπνο ασύρµατο σύστηµα δικτύου το οποίο έχει γνώση για το 
περιβάλλον γύρω του, αντλεί πληροφορίες από αυτό και µε µεθόδους εκµάθησης προσαρµόζει τις 
εσωτερικές του καταστάσεις στις µεταβολές κάνοντας αλλαγές σε συγκεκριµένες λειτουργικές παραµέτρους 
(ισχύς µετάδοσης, ραδιοσυχνότητα) σε πραγµατικό χρόνο, µε δύο κυρίως στόχους:  

• υψηλής αξιοπιστίας επικοινωνίες  
• αποδοτική χρήση του φάσµατος ραδιοσυχνοτήτων 

 
Αυτό που αξίζει να αναφερθεί είναι οι λόγοι για τους οποίους τα γνωστικά δίκτυα θεωρούνται κατάλληλα 
για τη χρήση τους. Οι καταναλωτές λειτουργούν µε πιό απαιτητικές απαιτήσεις όσον αφορά την ασφάλεια 
και το εύρος του φάσµατος της επικοινωνίας, αυξάνοντας συνεχώς την πρόκληση στον τοµέα των δικτύων. 
Τα δίκτυα λοιπόν από απλοί φορείς µετάδοσης δεδοµένων εξελίχθηκαν σε οντότητες που προσαρµόζουν την 
λειτουργία τους και τα χαρακτηριστικά τους ανάλογα µε τις απαιτήσεις των χρηστών φανερώνοντας την 
τάση πρός τα γνωστικά δίκτυα.  

 
 

Εικόνα 2.1  CR ∆ίκτυα 
 

 

2.3 Προγράµµατα βασισµένα στις αρχές του Cognitive Radio 
Υπάρχουν προγράµµατα τα οποία είναι βασισµένα στις αρχές της τεχνολογίας cognitive radio. Ένα τέτοιο 
πρόγραµµα είναι το Next Generation(xG), πρόγραµµα της DARPA, του Υπουργείου Άµυνας των ΗΠΑ. Το 
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xG, µέσω τεχνικών DSA, παρέχει ευρυζωνικές υπηρεσίες σε κινητούς χρήστες. 
Άλλο πρόγραµµα είναι το DRiVE(Dynamic Radio for IP Services in Vehicular Environments). Αποτελεί 
ευρωπαϊκή προσπάθεια και στόχος του είναι η συνύπαρξη διαφόρων ασύρµατων υπηρεσιών όπως GSM, 
GPRS, UMTS, DAB και DVB-T µε κοινό φάσµα λειτουργίας. Στο πρόγραµµα αυτό συµµετέχουν εταιρείες 
τηλεπικοινωνιών από όλη την Ευρώπη. 
Το πρόγραµµα CORVUS ανιχνεύει τις φασµατικές οπές στις αδειοδοτηµένες φασµατικές ζώνες. Στο 
πρόγραµµα αυτό υπάρχουν οι δικαιούχοι χρήστες και οι οµάδες χρήστών που αποτελούν τους δευτερεύοντες 
χρήστες(SUs). Κάθε SU εκτελεί ανίχνευση φάσµατος και τη φασµατική ζώνη που ανιχνεύει ως ανενεργή την 
χωρίζει σε κανάλια. Ο συντονισµός των SUs γίνεται µέσω του UCC(Universal Control Channel) και των 
GCCs(Group Control Channels). O ρόλος του UCC είναι η ανακοίνωση των υπαρχόντων SUs και µέσω 
αυτού γίνεται η ενηµέρωση για την άφιξη των νέων SUs. To GCC είναι µοναδικό σε κάθε οµάδα και είναι 
υπεύθυνο για την επικοινωνία µεταξύ των SUs της ίδιας οµάδας. 
Τέλος η ανάπτυξη του προτύπου ΙΕΕΕ 802.22 είναι βασισµένη στην ιδέα του cognitive radio. Το πρότυπο 
ΙΕΕΕ 802.22 δηµιουργήθηκε για την ανίχνευση και χρήση των φασµατικών οπών, από ασύρµατα τοπικά 
δίκτυα(WRANs) στη µπάντα της τηλεόρασης. Τα ΙΕΕΕ 802.22 WRANs είναι σχεδιασµένα να λειτουργούν 
χωρίς παρεµβολές στις συχνότητες της αναλογικής ή ψηφιακής τηλεόρασης. 

2.4 Χαρακτηριστικά του Cognitive Radio 
Ένα τηλεπικοινωνιακό σύστηµα χαρακτηρίζεται ως γνωστικό(cognitive) όταν γνωρίζει το περιβάλλον του, 
µπορεί να προσαρµόζεται σε αυτό µε βάση τις ανάγκες του χρήστη και είναι ικανό να µαθαίνει καινούργιες 
συµπεριφορές µέσω αυτόνοµων µηχανισµών µάθησης. Πρακάτω, εξηγούµε αναλυτικά τα τρία βασικά 
χαρακτηριστικά του Cognitive Radio τα οποία είναι η Συνείδηση, η Προσαρµοστικότητα και η Εκπαίδευση.  

Συνείδηση 
Το Cognitive  Radio  διαθέτει αισθητήρες ήχου, εικόνας, θέσης και συχνότητας. Αυτοί οι αισθητήρες 
συλλέγουν πληροφορίες για το περιβάλλον στο οποίο λειτουργεί. Για να θεωρηθεί ένα σύστηµα cognitive θα 
πρέπει να χρησιµοποιεί την πληροφορία που λαµβάνει µέσω των αισθητήρων του για να ικανοποιεί τις 
ανάγκες του χρήστη. Επιπλέον, το Cognitive Radio έχει αυτοεπίγνωση, διαθέτει δηλαδή ένα υπολογιστικό 
µοντέλο του εαυτού του, που του επιτρέπει να τροποποιεί µε ευελιξία λειτουργικά του τµήµατα 
ανταποκρινόµενο στις ανάγκες του χρήστη. Προσαρµόζεται δηλαδή στο εκάστοτε περιβάλλον. 

Προσαρµοστικότητα 
Σε  ένα τηλεπικοινωνιακό σύστηµα υπάρχουν πολλοί παράµετροι της λειτουργίας του που µπορούν να είναι 
προσαρµοστικές. Μερικές από αυτές είναι η φέρουσα συχνότητα, το εύρος ζώνης, το σχήµα διαµόρφωσης, ο 
κώδικας διόρθωσης σφαλµάτων, ο ρυθµός δεδοµένων και η ισχύς εκποµπής,. Ένα frequencyhopping 
σύστηµα που αλλάζει ακολουθίες µεταπήδησης για να µειώσει το ρυθµό συγκρούσεων µπορεί επίσης να 
θεωρηθεί προσαρµοστικό, όπως και ένα σύστηµα που µεταβάλλει το στιγµιαίο εύρος ζώνης του σαν 
συνάρτηση του φορτίου του δικτύου. Με άλλα λόγια, ένα σύστηµα που ανταποκρίνεται στις εκάστοτε 
συνθήκες µεταβάλλοντας τις παραµέτρους λειτουργίας του χωρίς να έχει προγραµµατιστεί εκ των προτέρων 
για αυτό, έχει την ιδιότητα της προσαρµοστικότητας, όπως την εννοούµε στην τεχνολογία Cognitive Radio. 

Μάθηση 
Η µάθηση περιλαµβάνει την ικανότητα του Cognitive Radio συστήµατος να αναλύει τα δεδοµένα που 
εισέρχονται στους αισθητήρες και βάση των συµπερασµάτων αυτής της ανάλυσης, να τροποποιεί την 
συµπεριφορά του. Η µάθηση µπορεί να επιτευχθεί µε ή χωρίς επίβλεψη. Η µάθηση µε επίβλεψη 
πραγµατοποιείται µε διάλογο µεταξύ του χρήστη και του συστήµατος, όπου το σύστηµα αναπτύσσει ένα νέο 
ισχυρισµό και στη συνέχεια ζητά επιβεβαίωση από το χρήστη ότι το συµπέρασµα που εξήγαγε είναι σωστό. 
Από την άλλη, στην µάθηση χωρίς επίβλεψη, το σύστηµα µπορεί να επεκτείνει τη γνώση του µέσω του 
αλγορίθµου µάθησης και απλώς να προσθέσει τη νέα γνώση. Το πρόβληµα µε την αυτόνοµη µάθηση 
µηχανής(autonomous machine learning–AML) είναι ότι η διαδικασία µάθησης µπορεί να οδηγήσει σε 
πολλές λανθασµένες επιλογές.  
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2.5 Ο Κύκλος της Γνώσης 
Η λειτουργία του CR χαρακτηρίζεται από τον Κύκλο της Γνώσης που εισήγαγε ο Mitola:  

  

 
Εικόνα 2.2   Κύκλος της γνώσης(Mitola)[4] 

 
 
Στον κύκλο αυτό διακρίνονται έξι βασικά στάδια[4]: Παρατήρηση (Observe), Προσανατολισµός (Orient) 
Σχεδιασµός (Plan), Απόφαση (Decide), ∆ράση (Act) και Μάθηση (Learn). 
 

1. Παρατήρηση: Το cognitive radio αναλύει τα εισερχόµενα ερεθίσµατα, έτσι ώστε να 
αποκτήσει γνώση για το περιβάλλον του. Αυτή η φάση συνδέει αυτά τα ερεθίσµατα µε 
προηγούµενες εµπειρίες µε σκοπό να αποκοµίσει χρήσιµα συµπεράσµατα. Ολόκληρη η 
πληροφορία σχετικά µε τις τηλεπικοινωνιακές καταστάσεις στις οποίες µπορεί να βρεθεί ο 
χρήστης σε διάστηµα ενός χρόνου καταλαµβάνουν µερικές εκατοντάδες gigabytes, ανάλογα µε 
το επίπεδο λεπτοµέρειας. Εποµένως, η αρχιτεκτονική µνήµης και συσχέτισης της τρέχουσας 
εµπειρίας µε όλες τις προηγούµενες είναι µία κεντρική ικανότητα του cognitive radio. 
 
2. Προσανατολισµός: Η φάση προσανατολισµού καθορίζει την σπουδαιότητα µιας 
παρατήρησης συνδέοντας την παρατήρηση µε ένα σύνολο ερεθισµάτων. Όταν υπάρχει απόλυτο 
ταίριασµα ανάµεσα στην τρέχουσα παρατήρηση και την προηγούµενη εµπειρία, έχουµε 
αναγνώριση ερεθίσµατος. Κάθε ερέθισµα ανήκει σε ένα ευρύτερο πλαίσιο, το οποίο 
περιλαµβάνει πρόσθετα ερεθίσµατα και σχετικές εσωτερικές καταστάσεις 
συµπεριλαµβανοµένου του χρόνου. Μερικές φορές, η φάση προσανατολισµού προκαλεί την 
άµεση εκκίνηση µιας ενέργειας ως ένα είδος αντανακλαστικής συµπεριφοράς. Μια ξαφνική 
απώλεια ηλεκτρικής ισχύος, για παράδειγµα, θα µπορούσε να προκαλέσει την άµεση 
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αποθήκευση των δεδοµένων του χρήστη (το “Immediate” µονοπάτι προς την φάση “Act” στην 
εικόνα). Μία µη αντιµετωπίσιµη απώλεια σήµατος σε ένα δίκτυο θα προκαλούσε 
επανεκχώρηση πόρων, για παράδειγµα, από την ανάλυση φωνής ως την αναζήτηση 
εναλλακτικών καναλιών. Αυτό αντιστοιχεί στο µονοπάτι “Urgent” στην εικόνα. 
Η σύνδεση συµβαίνει όταν υπάρχει ένα σχεδόν πλήρες ταίριασµα µεταξύ του παρόντος 
συνόλου ερεθισµάτων και µιας προηγούµενης εµπειρίας, ενώ ταυτόχρονα ισχύουν κάποια πολύ 
γενικά κριτήρια για την εφαρµογή της προηγούµενης εµπειρίας στην τρέχουσα κατάσταση. Ένα 
τέτοιο κριτήριο είναι το πλήθος των µη αντιστοιχισµένων χαρακτηριστικών στην παρούσα 
σκηνή. Αν ένα µόνο χαρακτηριστικό δεν ταιριάζει, τότε η σύνδεση µπορεί να είναι το πρώτο 
βήµα στο σχεδιασµό µιας συµπεριφοράς παρόµοιας µε τη συµπεριφορά στην πιο πρόσφατη 
συγκρίσιµη σκηνή. 

 
3. Σχεδιασµός: Τα περισσότερα ερεθίσµατα αντιµετωπίζονται µε προµελετηµένο τρόπο παρά 
αντανακλαστικά. Ένα εισερχόµενο µήνυµα από το δίκτυο θα αντιµετωπιζόταν µε τη δηµιουργία 
ενός σχεδίου. Τυπικά, οι ανακλαστικές αντιδράσεις είναι προγραµµατισµένες εκ των προτέρων 
ή µαθαίνονται µέσω ρητών εντολών του χρήστη, ενώ οι υπόλοιπες προµελετηµένες αντιδράσεις 
εκτελούνται µέσω σχεδίου. Σχεδιαστικά εργαλεία όπως το OPRS(Open Procedural Reasoning 
System) επιτρέπουν τη σύνθεση συµπεριφορών πρόσβασης στο φάσµα και στην πληροφορία µε 
βάση την αντίληψη του περιβάλλοντος, τους κανόνες της µηχανής µάθησης και τις προτιµήσεις 
του χρήστη που έχουν γίνει γνωστές από προηγούµενη χρήση. 
 
4. Απόφαση: Η φάση απόφασης διαλέγει ανάµεσα στα υποψήφια σχέδια. Το cognitive radio θα 
µπορούσε να ειδοποιήσει το χρήστη για ένα εισερχόµενο µήνυµα ή να αναβάλει τη διακοπή για 
αργότερα. Η απόφαση θα βασιζόταν σε µετρικές του QoI(quality of information) για την 
τρέχουσα σκηνή. 
 
5. ∆ράση: Αυτή η φάση ξεκινά τις επιλεγµένες διαδικασίες χρησιµοποιώντας ενεργοποιητές 
που προσπελαύνουν τον έξω κόσµο ή τις εσωτερικές καταστάσεις του cognitive radio. 
Πρόσβαση στον έξω κόσµο σηµαίνει κυρίως τη σύνθεση µηνυµάτων, είτε προφορικών που 
απευθύνονται στο τοπικό περιβάλλον είτε γραπτών που απευθύνονται σε ένα άλλο cognitive 
radio, γραµµένων σε  RXML(Radio XML) ή σε κάποιο άλλο πρότυπο ανταλλαγής γνώσης. Η 
δράση πάνω σε εσωτερικές καταστάσεις περιλαµβάνει τον έλεγχο πόρων όπως τα ασύρµατα 
κανάλια. 

 
6. Μάθηση: Αρχικά η µάθηση εξυπηρετείται από τη φάση παρατήρησης όπου η πληροφορία 
από τους αισθητήρες συσχετίζεται µε όλη την προηγούµενη εµπειρία. Κατόπιν το cognitive 
radio µαθαίνει καθ' όλη τη διάρκεια του κύκλου, δηλαδή από το σχεδιασµό, από τις αποφάσεις 
και από τη δηµιουργία νέων καταστάσεων που ενσωµατώνονται στην ήδη αποθηκευµένη 
γνώση. 

 
Από τα παραπάνω γίνεται φανερό ότι το cognitive radio επιδεικνύει την ικανότητα επαναδιάρθρωσης της 
δοµής και της λειτουργίας του. Η εικόνα δείχνει τις βασικές διεργασίες ενός cognitive radio[5], όπως αυτές 
προκύπτουν από έναν πιο γενικό Κύκλο Γνωστικής ∆ιαδικασίας του Mitola. Το CR παρατηρεί το 
περιβάλλον του και λαµβάνει αποφάσεις στηριζόµενο: 
 

• στις µετρήσεις µίας σειράς µεγεθών 
• στο ιστορικό των προηγούµενων παρατηρήσεών του 
• στις προτιµήσεις του χρήστη 

 
Μια απόφαση µετουσιώνεται σε δράση η οποία µπορεί να οδηγήσει σε δέσµευση µιας ζώνης συχνοτήτων 
για χρήση ή σε αποστολή κατάλληλων µηνυµάτων προς το χρήστη. Επιπλέον, το CR µπορεί να εκπαιδεύεται 
και να µαθαίνει. 
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Εικόνα 2.3  Νοητικές διεργασίες, όπως προκύπτουν από το Γνωστικό Κύκλο[5] 
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3. SPECTRUM SENSING   

3.1 Εισαγωγή 
Οι µελλοντικές ασύρµατες υπηρεσίες αναµένεται να παράσχουν δεδοµένα της τάξεως του 1 Gbps στην  
τοπική περιοχή και 100 Mbps στην ευρύτερη περιοχή. Ένα πολύ µεγάλο εύρος ζώνης(100 MHz) απαιτείται 
για την υποστήριξη τόσο µεγάλου όγκου δεδοµένων. Αυτό δεν είναι διαθέσιµο για κάθε χρήστη, έτσι η 
µεριζόµενη πρόσβαση στο ραδιοφάσµα µεταξύ των φορέων κρίνεται απαραίτητη. 
Όπως γίνεται αντιληπτό από τα παραπάνω, η ανίχνευση φάσµατος  αποτελεί ένα ιδιαιτέρως κρίσιµο θέµα 
για τα cognitive συστήµατα. Για να επιτευχθεί η προσαρµοστική µετάδοση σε αχρησιµοποίητα τµήµατα 
φάσµατος χωρίς να προκαλούνται παρεµβολές στους βασικούς χρήστες αυτών των τµηµάτων, το spectrum 
sensing αποτελεί το πρώτο και ένα από τα κυριότερα βήµατα καθώς απαιτείται υψηλή αξιοπιστία στην 
ανίχνευση του σήµατος των PUs(Primary Users). Οι δευτερεύοντες χρήστες, δηλαδή, θα πρέπει να 
γνωρίζουν αν το φάσµα χρησιµοποιείται ώστε να αξιοποιήσουν το διαθέσιµο φάσµα µε τον πιο αποδοτικό 
τρόπο . 

 
Εικόνα 3.1   Spectrum sensing in Cognitive Network[6] 

 
 

Ουσιαστικά, το spectrum sensing εφαρµόζεται για να δώσει στον cognitive χρήστη µια εικόνα του 
περιβάλλοντος στο οποίο βρίσκεται. Αν θέλαµε να δώσουµε ένα ορισµό για το spectrum sensing θα λέγαµε 
ότι είναι µια ποιοτική και ποσοτική ανάλυση του εύρους ζώνης που µας ενδιαφέρει µέσω της συλλογής 
πληροφοριών σχετικά µε τη χρήση των συχνοτήτων και την κατηγοριοποίησή τους.  

3.2 Χαρακτηριστικά Ανίχνευσης Φάσµατος 
Η ανίχνευση του φάσµατος[7][8] αποτελεί το πρώτο βήµα για την µετάδοση σε µεγάλα φάσµατα χωρίς να 
προκαλούνται παρεµβολές µεταξύ των PUs. Γι'αυτό το λόγο αποτελεί το σηµαντικότερο χαρακτηριστικό της 
τεχνολογίας cognitive radio όσον αφορά την κατανοµή των συχνοτήτων, καθώς διασφαλίζει επικοινωνία 
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χωρίς παρεµβολές και αναγνωρίζει τις δυνατότητες που υπάρχουν για αύξηση της χωρητικότητας των 
cognitive δικτύων. Για να µπορέσει να ανταπεξέλθει µε αξιοπιστία σε αυτούς τους ρόλους θα πρέπει να 
αντιµετωπίσει τα εξής ζητήµατα: 
 
Περιορισµένη ικανότητα ανίχνευσης: Οι SUs δεν µπορούν να αντιληφθούν την παρουσία άλλων χρηστών 
αποτελεσµατικά. Η ικανότητα ανίχνευσης σε µεγάλες φασµατικές περιοχές, η ανίχνευση του φάσµατος σε 
περιβάλλοντα πολλαπλών χρηστών και η µέτρηση της θερµοκρασίας παρεµβολών, αποτελούν ζητήµατα 
σχετιζόµενα µε αυτό που αποκαλούµε περιορισµένη ικανότητα ανίχνευσης.  
  
Ανίχνευση ευρείας ζώνης: Η ανίχνευση του φάσµατος καθίσταται δύσκολη υπόθεση, σε ένα πολύ ευρύ 
φάσµα συχνοτήτων. Γι'αυτό το λόγο προτάθηκε η λύση της χρήσης ενός περιορισµένου εύρους ζώνης όπου 
η δειγµατοληψία στο ρυθµό Nyquist, είναι εφικτή µε την παρούσα τεχνολογία. Το υπολογιστικό κόστος 
µπορεί να περιοριστεί σε λογικά επίπεδα και αποφεύγεται το µονοπώλιο των ευκαιριών του φάσµατος, απο 
ένα µόνο τύπο CR.  
 
Μέτρηση παρεµβολών: Η χρήση της θερµοκρασίας παρεµβολών αποτελεί µία σηµαντική προσέγγιση για 
τη δυναµική διαχείριση του διαθέσιµου φάσµατος. Οι cognitive χρήστες µπορούν ελεύθερα να µεταδίδουν 
µε την προυπόθεση οτι δεν αυξάνουν τη θερµοκρασία παρεµβολών πάνω ένα όριο,.  
Οι προκλήσεις του spectrum sensing από τη µέτρηση της θερµοκρασίας παρεµβολών, είναι ο καθορισµός 
των παρεµβολών σε συνάρτηση του χώρου και της συχνότητας και η µέτρηση στη σωστή θέση της 
θερµοκρασίας παρεµβολών. Η δεύτερη αναφέρεται στο πρόβληµα κατά το οποίο οι SUs δεν έχουν τη 
δυνατότητα να γνωρίζουν τις ακριβείς θέσεις των PUs και δε µπορούν να µετρήσουν τις επιδράσεις των 
µεταδόσεών τους στους πιθανούς δέκτες. 
 
Ανίχνευση φάσµατος σε περιβάλλον πολλαπλών χρηστών: Το περιβάλλον της cognitive radio 
τεχνολογίας αποτελείται από ένα σύνολο PUs και SUs. Τα cognitive δίκτυα µπορεί να συνυπάρχουν στον 
ίδιο χώρο µαζί µε άλλα δευτερεύοντα δίκτυα ανταγωνιζόµενα για τους ίδιους φασµατικούς πόρους. Επίσης 
οι SUs είναι πιθανό να παρεµβάλλονται µεταξύ τους επηρεάζοντας δραστικά την απόδοση του spectrum 
sensing.  
Σε ένα τέτοιο περιβάλλον πολλαπλών χρηστών, η συνεργασία µεταξύ των SUs κρίνεται απαραίτητη, από 
την άλλη όµως προκύπτουν διάφορα ζητήµατα όπως οι καθυστερήσεις που πρέπει να είναι µικρές καθώς σε 
αντίθετη περίπτωση, θα υπάρχουν πολύ λίγοι πόροι διαθέσιµοι. 

3.3 Τεχνικές Ανίχνευσης Φάσµατος 
Η λύση του cooperative spectrum sensing δηλαδή της συνεργασίας µεταξύ των cognitive χρηστών είναι 
αυτή που προτείνεται από τους ερευνητές στην απαίτηση για καλύτερη απόδοση του spectrum sensing. Ένας 
PU ίσως να µην είναι ορατός από ένα SU εξαιτίας των συνθηκών του καναλιού, αλλά µία οµάδα από SUs 
δεν θα αντιµετωπίσει τέτοιο πρόβληµα. Σε ένα κεντρικοποιηµένο σύστηµα συνεργασίας, οι πληροφορίες που 
προκύπτουν από το sensing του κάθε κόµβου στέλνονται σε ένα κοινό κανάλι ελέγχου και αφού 
συνδυαστούν στο σταθµό βάσης επανεκπέµπονται στους SUs του δικτύου. Ωστόσο, η αποδοτικότητα της 
χρήσης του φάσµατος µπορεί να είναι χαµηλότερη και να µην υπάρχει δικαιοσύνη µεταξύ των SUs. Η 
συνεργασία καθίσταται περισσότερο αναγκαία σε δίκτυα µε πολλούς χρήστες σε αντίθεση µε τα δίκτυα στα 
οποία η κίνηση δεν είναι µεγάλη και στα οποία οι SUs µπορούν να δρουν αυτόνοµα.  

  
Γενικά, οι τεχνικές ανίχνευσης φάσµατος[9] µπορούν να κατηγοριοποιηθούν σε τρεις µεγάλες κατηγορίες: 
 

1. ανίχνευση από τον κάθε SU ξεχωριστά  
2. ανίχνευση µε συνεργασία µεταξύ των SUs  
3. και η ανίχνευση που βασίζεται στις παρεµβολές 

 
Η ακόλουθη εικόνα παρουσιάζει αυτή την κατηγοριοποίηση εµφανίζοντας από την πρώτη περίπτωση τις 
τρεις βασικότερες τεχνικές οι οποίες είναι η ανίχνευση ενέργειας (energy detection), η ανίχνευση µε τη 
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χρήση προσαρµοσµένου φίλτρου (matched filter detection), και η ανίχνευση που βασίζεται στην 
κυκλοστατικότητα (cyclostationary featured detection). 

 

 
 

Εικόνα 3.2  Τεχνικές ανίχνευσης φάσµατος 
 
 
3.4 ∆ιαµοιρασµός φάσµατος 

Ισχύων καθεστώς ανάθεσης συχνοτήτων 
Στο ισχύον καθεστώς ανάθεσης συχνοτήτων, οι πάροχοι που επιθυµούν να εκπέµπουν σε µια περιοχή 
συχνοτήτων, ζητούν τη χορήγηση της σχετικής άδειας από τις αρµόδιες κρατικές ρυθµιστικές αρχές οι 
οποίες είναι υπεύθυνες σε θέµατα επικοινωνιών. Η διαδικασία αυτή είναι χρονοβόρα µε υψηλό κόστος και 
έχει σαν αποτέλεσµα την στατική και αποκλειστική χρήση µιας ζώνης συχνοτήτων. Ο κύριος στόχος της 
διαδικασίας ανάθεσης συχνοτήτων, είναι η αποφυγή παρεµβολών. Τα σηµαντικότερα µειονεκτήµατα του 
ισχύοντος σχήµατος είναι τα εξής: 
 

• Ο πάροχος αιτείται ένα φασµατικό τµήµα σύµφωνα µε το φορτίο του δικτύου του σε ώρα αιχµής, µε 
αποτέλεσµα ένα µεγάλο τµήµα του φάσµατος να µένει ανεκµετάλλευτο κατά την διάρκεια της 
ηµέρας. 

• Ένας πάροχος είναι δυνατόν να αναπτύσει το δικτυό του σε συγκεκριµένη γεωγραφική περιοχή, µε 
αποτέλεσµα η συγκεκριµένη ζώνη συχνοτήτων να παραµένει, σε µεγάλο βαθµό, χωρικά 
ανεκµετάλλευτη.  

• Ο πάροχος για να καλύψει πιθανές µελλοντικές αυξηµένες ανάγκες σε φάσµα, για την ανάπτυξη 
νέων υπηρεσιών και για να παρακάµψει την επανάληψη της διαδικασίας ανάθεσης, ενδέχεται να 
αγοράζει φάσµα  µεγαλύτερο απο αυτό που απαιτείται για την κάλυψη των τρεχουσών αναγκών του. 

 
Το τρέχων σχήµα ανάθεσης συχνοτήτων κρίνεται πλέον ως αναποτελεσµατικό, καθώς παρουσιάζεται 
υπερβολική συµφόρηση σε ορισµένες ζώνες, ενω άλλες υποχρησιµοποιούνται. Η εικόνα 2.3 που ακολουθεί 
παρουσιάζει τα αποτελέσµατα έρευνας που διεξάχθηκε σε 6 περιοχές των Ηνωµένων Πολιτειών και 
αποδεικνύει την υποχρησιµοποίηση των φασµατικών συχνοτήτων .   
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Εικόνα 3.3  Υποχρησιµοποίηση φασµατικών συχνοτήτων[10] 

 
 

3.5 Ευκαιριακή χρήση συχνοτήτων 
Τα γνωστικά δίκτυα προσφέρουν µια λύση στο προαναφερθέν πρόβληµα προτείνοντας την ευκαιριακή 
χρήση των συχνοτήτων που δεν χρησιµοποιούνται καθόλου ή χρησιµοποιούνται σε µικρό βαθµό από 
δευτερεύοντες χρήστες, µε την προϋπόθεση  να µην προκαλούν παρεµβολές στους πρωτεύοντες χρήστες. Οι 
ζώνες συχνοτήτων µε µικρό η µηδενικό βαθµό χρησιµοποίησης χαρακτηρίζονται συχνά ως οπές φάσµατος 
(spectrum holes). 
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Εικόνα 3.4  Φασµατικές οπές σε 2 διαστάσεις[8] 

 
 
Ο S. Haykin[4]  διακρίνει το φάσµα συχνοτήτων στις εξής κατηγορίες: 

• Λευκοί χώροι : Ζώνες συχνοτήτων που είναι απαλλαγµένες από παρεµβολές και χαρακτηρίζονται 
µόνο από την παρουσία θορύβου. 

• Γκρί χώροι : Ζώνες συχνοτήτων που χαρακτηρίζονται από την παρουσία παρεµβολών χαµηλής 
ισχύος. 

• Μαύροι χώροι: Ζώνες συχνοτήτων που χαρακτηρίζονται από την παρουσία παρεµβολών υψηλής 
ισχύος. 

 
Oι λευκοί και οι γκρί χώροι είναι υποψήφιοι για ευκαιριακή χρήση, όπως προβλέπεται από την αρχή 
λειτουργίας των γνωστικών δικτύων. Οι χρήστες που θα κάνουν ευκαιριακή χρήση των χώρων αυτών, δεν 
θα πρέπει να προκαλούν παρεµβολές στους πρωτεύοντες χρήστες. Ως αποτέλεσµα αυτού, είναι απαραίτητη 
η χρήση κατάλληλων µέτρων για το χαρακτηρισµό µιας ζώνης συχνοτήτων ως ελεύθερης ή µη παρεµβολών. 

3.6 Μέτρα εκτίµησης παρεµβολών 
∆ύο µέτρα αποτελούν τα πλέον διαδεδοµένα στη διαδικασία εκτίµησης των παρεµβολών: 

• ο λόγος σήµατος προς παρεµβολή και θόρυβο (Signal to Noise plus Interference Ratio - SNR)  
• και η θερµοκρασία παρεµβολών (Interference Temperature - IT). 

3.6.1 Λόγος σήµατος προς παρεµβολή και θόρυβο 
Η ισχύς των παρεµβολών δεν µπορεί να περιγράψει από µόνη της την επίδραση των παρεµβολών καθώς 
πρέπει να εξεταστεί σε σύνδεση µε την ισχύ του λαµβανόµενου σήµατος. Ένα κατάλληλο µέτρο της 
ποιότητας του λαµβανόµενου σήµατος είναι ο λόγος της ισχύος του επιθυµητού λαµβανόµενου σήµατος 
προς το ολικό άθροισµα των ισχύων παρεµβολής, όπως φαίνεται στην παρακάτω εξίσωση : 
 

   S /  I  = S / Σn In + N 
 

όπου το S δηλώνει την ισχύ του επιθυµητού σήµατος, το Ιn την ισχύ παρεµβολής που προέρχεται απο τον 
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παρεµβολέα n, και το N το θερµικό θόρυβο. Η εκτίµηση του SNR  είναι καίριας σηµασίας για την 
λειτουργία των ασύρµατων συστηµάτων επικοινωνιών. 

3.6.2 Θερµοκρασία παρεµβολών 
Ένα µέτρο που εισήχθη, σχετικά πρόσφατα, από την Οµοσπονδιακή Επιτροπή Επικοινωνιών(Federal 
Communications Commision – FCC) των Ηνωµένων Πολιτειών Αµερικής για την ποσοτικοποίηση της 
παρουσίας παρεµβολών είναι η θερµοκρασία παρεµβολών. Η θερµοκρασία παρεµβολών ορίζεται, κατ’ 
αναλογία µε τη θερµοκρασία θορύβου µιας κεραίας, ως: 

 

ΤΙ  =Ι /κΒ 
 

όπου το Ι  δηλώνει την ισχύ παρεµβολών σε Watt, B το εύρος ζώνης σε Hertz  και k η σταθερά Boltzmann 
ίση µε 1.38x10-23 Joule ανά βαθµό Kelvin. Μέσω του µεγέθους της θερµοκρασίας παρεµβολών, λοιπόν, 
γίνεται προσπάθεια ρύθµισης της λαµβανόµενης ισχύος αντί της εκπεµπόµενης, σε αντίθεση µε το ισχύον 
µοντέλο το οποίο προβλέπει ρύθµιση της εκπεµπόµενης ισχύος, ώστε να προσεγγίσει ένα δεδοµένο επίπεδο 
θορύβου σε συγκεκριµένη απόσταση από τον ποµπό. Η εκτίµηση της θερµοκρασίας παρεµβολών µπορεί να 
αποδειχθεί ένα εξαιρετικά δύσκολο έργο. 

3.7 Μηχανισµοί δηµοπρασίας  
Η αποδοτική λειτουργία των γνωστικών δικτύων βασίζεται στην ανάθεση φάσµατος σε δευτερεύοντες 
χρήστες όταν ο αδειοδοτηµένος χρήστης δεν το χρησιµοποιεί. Τα γνωστικά δίκτυα λειτουργούν βάσει  
ισχύος συχνότητας και χρόνου. Υπάρχουν διαφορετικοί µηχανισµοί ανάθεσης ανάλογα µε το είδος του 
πόρου(φάσµα, ισχύς ή χρόνος). Το βασικό θέµα που προκύπτει είναι ο τρόπος ανάθεσης των πόρων αυτών. 
Η ιδέα που υιοθετείται από όλα τα πρωτόκολλα, είναι ότι τα προς ανάθεση τµήµατα του πόρου εισέρχονται 
σε µια διαδικασία δηµοπρασίας[11]. Μια δηµοπρασία εκτελείται περιοδικά οπότε οι υποψήφιοι πάροχοι 
ασύρµατων υπηρεσιών ή WSPs(Wireless Service Providers) µπορούν να καταθέτουν τις προσφορές τους 
στον κάτοχο του πόρου. 
Για την περίπτωση που ο πόρος είναι φάσµα, το φάσµα κατοχυρώνεται από το νικητή WSP της δηµοπρασίας 
για αποκλειστική χρήση για µία περίοδο µίσθωσης. Μετά την ολοκλήρωση της περιόδου µίσθωσης οι 
φασµατικές περιοχές ελευθερώνονται, η δηµοπρασία επαναλαµβάνεται έχοντας νέους νικητές WSPs. Η 
διαδικασία της δηµοπρασίας επαναλαµβάνεται συνεχώς δίνοντας σε κάθε δευτερεύοντα χρήστη τη 
δυνατότητα, να κερδίσει το φασµατικό τµήµα, υπό την προυπόθεση ότι θα καταθέσει την καλύτερη 
προσφορά.  

 
Ενδεικτικοί µηχανισµοί δηµοπρασιών: 
 

1.∆ηµοπρασία ανάθεσης ενός φασµατικού τµήµατος: Κατά τη δηµοπρασία αυτή 
υποθέτουµε ότι τα φασµατικά τµήµατα έχουν για όλους τους WSPs(wireless service 
providers) την ίδια αξία. ∆ηλαδή δεν υπάρχει προτίµηση απόκτησης συγκεκριµένων 
φασµατικών τµηµάτων. Οπότε ο κάθε WSP θα προσφέρει το ίδιο ποσό για όλα τα 
φασµατικά τµήµατα. 

 
2. ∆ηµοπρασία µε πρόσβαση TDMA και χρήση χρονικού τµήµατος πληρωµής: Ο 
συγκεκριµένος µηχανισµός δηµοπρασίας των φασµατικών πόρων στηρίζεται στην ιδέα της 
δευτερεύουσας αγοράς πραγµατικού χρόνου αλλά η πληρωµή στον κυρίαρχο χρήστη δεν 
γίνεται µε χρηµατικό ποσό αλλά µε χρονικά τµήµατα. Πιο συγκεκριµένα ένας σταθµός 
βάσης συλλέγει τις προσφορές από όλους τους δευτερεύοντες χρήστες και στη συνέχεια 
αναθέτει το φασµατικό τµήµα στο χρήστη µε τη µεγαλύτερη προσφορά, ο οποίος πληρώνει 
τιµή ίση µε την δεύτερη µεγαλύτερη προσφορά. 
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3.∆ηµοπρασίες  φασµατικών τµηµάτων µε χρήση µηχανισµού VCG: Το συστηµατικό 
µοντέλο που χρησιµοποιείται για την περιγραφή των δηµοπρασιών περιλαµβάνει µια 
φασµατική αγορά πραγµατικού χρόνου µε κυρίαρχους και δευτερεύοντες χρήστες. Οι 
κυρίαρχοι χρήστες παραχωρούν µέρη των φασµατικών ζωνών που τους έχουν διατεθεί 
στους δευτερεύοντες και η ανάθεση των φασµατικών τµηµάτων γίνεται µε δηµοπρασίες 
και χρήση του µηχανισµού VCG. Ίδια φασµατικά τµήµατα δεν µπορούν να παραχωρηθούν 
για το ίδιο χρονικό διάστηµα σε παραπάνω από δύο χρήστες. 

 
4.Αλγόριθµος VERITAS: Ο αλγόριθµος VERITAS είναι ένας αλγόριθµος κατανοµής 
φασµατικών πόρων και υπολογισµού του κόστους απόκτησής τους. Βασίζεται σε κλειστή 
δηµοπρασία όπου όλοι οι ενδιαφερόµενοι χρήστες αποστέλλουν τις προσφορές τους και 
τον αριθµό τον καναλιών τον οποίο επιθυµούν. Ο αλγόριθµος αυτός επιτυγχάνει την 
αποστολή αληθών προσφορών από τους χρήστες καθώς και την υπολογιστικά αποδοτική 
διάθεση φάσµατος σε αυτούς και χρέωση τους. 

3.8 Συνάρτηση ωφέλειας 
Κάθε αντικείµενο x το οποίο δηµοπρατείται έχει µία ωφέλεια για τον πλειοδότη η οποία ορίζεται από την 
συνάρτηση ωφέλειας u(x)[11]. Ο πλειοδότης καθορίζει την αξία του αντικειµένου της δηµοπρασίας και 
συνυπολογίζει το ποσό που είναι διατεθειµένος να προσφέρει για να το αποκτήσει. Αν το κόστος αυτό 
ονοµαστεί c(x), τότε ορίζεται η διαφορά ωφέλειας και κόστους και ονοµάζεται καθαρή ωφέλεια (net 
benefit), NB = u(x)−c(x). Προφανώς για τον πλειοδότη θα πρέπει NB ≥ 0, έτσι ώστε να είναι ωφέλιµη η 
απόκτηση του αντικειµένου. Το κόστος εξαρτάται από δύο παράγοντες: 
 
• Το µηχανισµό δηµοπρασίας 
• Από τις προσφορές των πλειοδοτών bi 

 
Με βάση τα παραπάνω προκύπτει:  

 

NB = u(x)−c(b1,b2,....,bn) 
 

Κατά  τη  διαδικασία  της δηµοπρασίας ο πλειοδότης καταθέτει τη προσφορά του b(x) στο πωλητή µε σκοπό 
την απόκτηση του αντικειµένου x. Πρέπει να γίνει σαφές ότι η ωφέλεια του κάθε πλειοδότη είναι η 
αξιολόγηση του αντικειµένου που θέλει να αποκτήσει ενώ η προσφορά είναι το ποσό που προσφέρει για να 
το αποκτήσει. Η ωφέλεια είναι µεγαλύτερη ή ίση µε την προσφορά και ποτέ µικρότερη από αυτήν. Αν η 
προσφορά γίνει ίση µε το κόστος c που καταβάλει ο πλειοδότης για την απόκτηση του αντικειµένου και η 
ωφέλεια είναι ίση µε την προσφορά b, δηλαδή προσφέρει την εκτίµησή του, τότε το καθαρό όφελος του 
πλειοδότη ΝΒ γίνεται µηδέν και τα έσοδα του πωλητή µεγιστοποιούνται.  
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4. ΑΝΑΛΥΣΗ-ΠΑΡΟΥΣΙΑΣΗ ΠΡΟΣΟΜΟΙΩΤΗ COGNITIVE RADIO 

4.1 Εισαγωγή 
Τα τελευταία χρόνια έχει παρουσιαστεί η ανάγκη για αρχιτεκτονικές οι οποίες θα υποστηρίζουν τεχνολογίες 
πολλαπλής πρόσβασης µε σκοπό να είναι σε θεση να καλύψουν τις υφιστάµενες τεχνολογίες ασύρµατης 
επικοινωνίας. Βασικό χαρακτηριστικό της ανάγκης αυτής είναι οτι ο χρήστης να µπορεί να χρησιµοποιεί 
διαφορετικές τεχνολογίες πρόσβασης(RAT) για την επίτευξη των επιθυµητών αποτελεσµάτων. Κάθε RAT 
δεν είναι ικανή να αντιµετωπίσει όλες τις πιθανές καταστάσεις αλλά µόνο ορισµένες απο αυτές που πιθανόν 
να συναντήσει ένας χρήστης όσον αφορά την περιοχή κάλυψης, την ικανότητα εκποµπής και την 
υποστήριξη κινητικότητας. Γι'αυτό τον λόγο ο χρήστης ενός δικτύου θα πρέπει να είναι σε θέση να 
επωφεληθεί από τον συνδιασµό των χαρακτηριστικών, διαφορετικών τεχνολογιών πρόσβασης. 
Τελευταία παρουσιάζεται πρόοδος στην χρήση ετερογενών RAT, το σηµαντικό όµως πρόβληµα του 
περιορισµού του διαθέσιµου ραδιοφάσµατος παραµένει. Αυτό ακριβώς έρχεται να αντιµετωπίσει η 
γνωσιακή ραδιοεπικοινωνία, η οποία φαίνεται να διαθέτει τα χαρακτηριστικά που της επιτρέπουν να 
αντιµετωπίζει αποτελεσµατικά την ασυµβατότητα µεταξύ των τεχνολογιών, καθώς και την 
υποχρησιµοποίηση του φάσµατος µε την ικανότητα της να επαναπροσδιορίζει τον τρόπο λειτουργίας της. 

4.2 Παρουσίαση 
Η συγκεκριµένη εφαρµογή έχει κατασκευαστεί σε Microsoft Visual Studio. Η γλώσσα προγραµµατισµού  
που χρησιµοποιήθηκε είναι η C-sharp, η οποία είναι αντικειµενοστραφής και παρουσιάζει πολλές 
οµοιότητες µε την java. Αποτελεί εξέλιξη µίας ιδέας που έχει παρουσιαστεί στην διπλωµατική εργασία µε 
τίτλο ''Ανάπτυξη πλατφόρµας προσοµοιώσεων για γνωστικά δίκτυα σε περιβάλλοντα πέραν της τρίτης 
γενιάς'' του Βασίλειου Χ.Μαντζούκα[12]. 
Σκοπός του προσοµοιωτή cognitive radio της παρούσας πτυχιακής εργασίας, είναι να εκτελεί διαφορετικά 
σενάρια όπως αυτό που θα αναπτυχθεί παρακάτω, για την διεξαγωγή κρίσιµων συµπερασµάτων για την 
απόδοση και τα πλεονεκτήµατα των γνωστικών δικτύων. Εισάγεται η τεχνική της δηµοπρασίας και της 
εκτέλεσης πολλαπλών σεναρίων στοιχεία που χαρακτηρίζουν την λειτουργία των γνωστικών δικτύων 
επικοινωνιών. Ο προσοµοιωτής εκτελεί αλγόριθµους οι οποίοι υπολογίζουν την µέγιστη περιοχή κάλυψης το 
uplink load factor καθώς και το κέρδος των basestations πρίν και µετά την διενέργεια δηµοπρασίας. Επίσης ο 
χρήστης µπορεί να εκτελέσει όσα διαφορετικά σενάρια επιθυµεί µεταβάλλοντας τα δεδοµένα που εισάγει 
και παρατηρώντας την διαφοροποίηση στα αποτελέσµατα. Τέλος παρέχεται η δυνατότητα γραφικής 
αναπαράστασης του υλοποιηµένου δικτύου, αλλά και των αποτελεσµάτων που προκύπτουν από τους 
υπολογισµούς των αλγορίθµων για ευκολότερη παρατήρηση και κατανόηση από τον χρήστη της 
πλατφόρµας.   
Παρακάτω γίνεται ανάλυτική παρουσίαση της εφαρµογής µε την προσοµοίωση ενός τυχαίου σεναρίου, στο 
οποίο ο χρήστης προσδιορίζει το πλήθος των σταθµών και των χρηστών καθώς και την τεχνολογία 
πρόσβασης(RAT) και το πρόγραµµα κατόπιν επιλογής του χρήστη, δίνει τυχαίες τιµές στα υπόλοιπα πεδία. 
Ο χρήστης έχει την δυνατότητα αν το επιθυµεί να εισάγει χειροκίνητα όλα τα δεδοµένα υλοποιώντας ένα 
συγκεκριµένο σενάριο.  
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4.3 Εκτέλεση και αποτελέσµατα 

 

 

 
Εικόνα 4.1  RAT Simulator 

 
 

  
Στην εικόνα 4.1 βλέπουµε το περιβάλλον της υλοποιηµένης πλατφόρµας, που πραγµατοποιεί προσοµοίωση 
Cognitive Radio δικτύου. Παρατηρούµε οτι υπάρχει ένα Toolbar µε το µενού που υλοποιεί τις διαθέσιµες 
λειτουργίες καθώς επίσης και ένα StatusBar που µας ενηµερώνει για τα σενάρια που έχουµε µέχρι στιγµής 
τρέξει. Παρακάτω γίνεται παρουσίαση του διαθέσιµου µενού αναλυτικά . 
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Base Stations : Εισάγουµε τα δεδοµένα που επιθυµούµε για τους basestations, όπως συντεταγµένες θέσης 
και RAT. 
 
Users : Εισάγουµε τα δεδοµένα που επιθυµούµε για τους users, όπως συντεταγµένες θέσης και τιµή 
προσφοράς. 
 
Toolbar : Εµφανίζει ένα toolbar κάτω από το µενού. 
 
Status Bar : Εµφανίζει ένα status µε το πλήθος των σεναρίων που έχουν υλοποιηθεί. 
 

 
Εικόνα 4.2  Status Bar 

 
 
Settings: Καθορίζουµε το ακριβές όριο των Users που µπορούν να συνδεθούν στα Basestations, καθώς 
επίσης και τη µέγιστη τιµή για την προσφορά στις δηµοπρασιες. 
 
 

 
Εικόνα 4.3  Settings 

 
Save : Σώζει τα αποτελέσµατα από τις δύο εγαρµογές του προγράµµατος σε excel αρχεία για πιό εύκολη 
παρατήρηση και αναλυσή τους, καθώς επίσης και τα γραφήµατα . 
 
Exit : Έξοδος από το πρόγραµµα . 
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Ξεκινώντας την προσοµοίωση του δικτύου απαιτείται η εισαγωγή των αντικειµένων που θα το απαρτίζουν.  
Εισάγουµε τους BaseStations(Data->BaseStations), όπως φαίνεται στην παρακάτω εικόνα. 
 
 
 

 
Εικόνα 4.4  Data->BaseStations 

 

Εικόνα 4.5  Base Stations Window 
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Εικόνα 4.6  Base Stations Window(zoom) 

 
 
Στην εικόνα 4.6 παρουσιάζεται το εικoνίδιο που εµφανίζεται για την εισαγωγή των δεδοµένων για τα 
Basestations, ο συνολικός αριθµός τους(15) καθώς και οι τιµές για ένα από αυτά, όσον αφορά τις 
συντεταγµένες θέσης(266,794) και την RAT(UMTS). Με το πλήκτρο Add προσθέτουµε χειροκίνητα νέους 
Basestations ενώ µε το Update ενηµερώνουµε το πρόγραµµα για τις νέες εισαγωγές. Υπάρχει επίσης η 
δυνατότητα να επιλέξουµε το πλήθος των Basestations που θέλουµε να εισαχθούν και πατώντας το πλήκτρο 
Random αυτό να γίνει αυτόµατα, χρήση της οποίας γίνεται στο συγκεκριµένο σενάριο. Επιλέγουµε το 
RAT(RADIO ACCESS TECHNOLOGY) που θέλουµε να χρησιµοποιεί ο κάθε Basestation µεταξύ των 
τεχνολογιών GSM,UMTS και WLAN. Το πρόγραµµα παρέχει επίσης την δυνατότητα στον χρήστη, αν αυτός 
το επιθυµεί, να δηµιουργήσει οµοιογενή δίκτυα εύκολα και γρήγορα εισάγοντας BaseStations ίδιας 
τεχνολογίας απλά επιλέγοντας το πλήθος και το RAT. 
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Εν συνεχεία,  εισάγουµε  τα  δεδοµένα  για  τους  Users  που  υλοποιούν  το  πρώτο  σενάριο  CR  δικτύου 
(Data->Users), όπως φαίνεται στην παρακάτω εικόνα . 
 
 
 

 
Εικόνα 4.7  Data->Users 

 
 

 

 
Εικόνα 4.8  User's Scenario 1 Window 
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Εικόνα 4.9  User's Scenario 1 Window(zoom) 

 
 
Στην εικονα 4.9 παρουσιάζεται το εικονίδιο που εµφανίζεται για την εισαγωγή των δεδοµένων για τους 
Users που υλοποιούν το πρώτο σενάριο CR δικτύου που θα εκτελέσουµε, ο συνολικός αριθµός τους(600), οι 
συντεταγµένες θέσης (437,8), το ονοµά τους, καθώς και η προσφορά(σε ευρό) που καταθέτει ο χρήστης για 
την δηµοπρασία του φάσµατος. Και εδώ υπάρχουν πλήκτρα εισαγωγής Users είτε αυτόµατα είτε 
χειροκίνητα. Σε αυτό το εικονίδιο υπάρχουν επίσης τρείς επιλογές που πραγµατοποιούν τρείς διαφορετικές 
εφαρµογές του προγράµµατος(Max,Effective,Normalize). Πατώντας το κουµπί Normalize εµφανίζεται το 
παρακάτω παράθυρο(Εικόνα 4.10). 
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Εικόνα 4.10  Normalized User's Scenario1 

 
 

Εδώ παρατηρούµε οτι υπάρχει µια λίστα µε τους Users(26) του δικτύου που συνδέονται σε ένα 
συγκεκριµένο Basestation(BaseStation1). Εµφανίζονται κάποιες πληροφορίες σχετικά µε τους χρήστες, όπως 
το όνοµα, οι συντεταγµένες, το Basestation στο οποίο έχουν συνδεθεί µε κριτήριο την απόσταση  καθώς και 
η προσφορά που έχει καταθέσει ο κάθε χρήστης. Επίσης παρουσιάζεται το πλήθος των χρηστών που 
αποκλείστηκαν(Exclusions:6) επειδή ο σταθµός βάσης ξεπέρασε το µέγιστο αριθµό χρηστών που µπορεί να 
εξυπηρετήσει και το κέρδος για τον κάθε σταθµό ξεχωριστά(BaseStation 1 Value(111)). Αντιστοίχως 
επιλέγοντας κάποιο άλλο baseStation στο filter by station, εµφανίζονται τα ανάλογα αποτελέσµατα και για 
τους υπόλοιπους σταθµούς. Τέλος το πρόγραµµα µας δίνει την δυνατότητα να αναπαραστήσουµε το δίκτυο 
µε γραφικό(Graph).(Εικόνα 4.11) 
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Εικόνα 4.11  Normalized graph with Scenario 1 

 
 
Στο γραφικό αυτό γίνεται παρουσίαση των Basestations(µε µαύρες κουκίδες) των Users που συνδέονται σε 
αυτούς(µε πράσινες κουκίδες) µε κριτήριο ποιός Basestation είναι πιό κοντά και µπορεί να εξυπηρετήσει 
καλύτερα τον User. Με τις κόκκινες κουκίδες αναπαριστούνται οι χρήστες που αποκλείστηκαν λόγω 
µεγάλου πλήθους χρήστων και µη ικανότητας των σταθµών να τους εξυπηρετήσουν. 
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Από την Εικόνα 4.10 παρατηρούµε οτι υπάρχει µια ακόµα επιλογή, το Bid. Επιλεγοντάς το εµφανίζεται το 
εξής παράθυρο.(Εικόνα 4.12) 
 

 

 
Εικόνα 4.12  Bid User's Scenario 1 

 
 
Σε αυτό το παράθυρο παρουσιάζονται οι Users που έχουν συνδεθεί στα Basestations κατόπιν της διαδικασίας 
της δηµοπρασίας, ανάλογα µε τις προσφορές που έχουν καταθέσει. Οι πιό συµφέρουσες προσφορές έχουν 
προτεραιότητα στην παροχή του διαθέσιµου ραδιοφάσµατος, ενώ οι υπόλοιποι χρήστες που δεν κατάφεραν 
να συνδεθούν θα τους δωθεί η ευκαιρία να το κάνουν σε µεταγενέστερο χρόνο.  
Και εδώ παρουσιάζονται διάφορες πληροφορίες σχετικά µε τους χρήστες όπως το όνοµα, οι συντεταγµένες 
το Basestation στο οποίο έχουν συνδεθεί µε κριτήριο την τιµή προσφοράς, καθώς και η ακριβής προσφορά 
που έχει καταθέσει ο κάθε χρήστης. Το πρόγραµµα υπολογίζει το κέρδος του κάθε σταθµού σε 
ευρό(basestation1 value:130) και δίνει την δυνατότητα στον χρήστη, µε την επιλογή του Comparison Graph 
να συγκρίνει το κέρδος των σταθµών προ και µετά δηµοπρασίας παρουσιάζοντας το παρακάτω 
γραφικό(Εικόνα 4.13). 
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Εικόνα 4.13  Comparative Graph  with Scenario's 1 

 
 

Στην εικόνα 4.13 παρατηρούµε οτι το κέρδος είναι µεγαλύτερο για τους BaseStations µετά την διαδικασία 
της δηµοπρασίας και αυτό ωφείλεται στο γεγονός, ότι η σχέση κέρδους υπολογίζεται από τις καλύτερες 
προσφορές που έχουν καταθέσει οι χρήστες, στους οποίους τελικά και επιτράπηκε η χρήση του διαθέσιµου 
ραδιοφάσµατος. Επίσης, το γραφικό αυτό, µας βοηθάει να παρατηρήσουµε µε ευκολία ποιός BaseStation 
είναι πιό κερδοφόρος(BaseStation 6 / value 191). 
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Εικόνα 4.9 User's Scenario 1 Window 

 
 
 

Επιστρέφοντας στο παράθυρο της εικόνας 4.9 παρατηρούµε οτι υπάρχουν δύο ακόµα εφαρµογές. Η πρώτη 
είναι το Max που υπολογίζει την µέγιστη περιοχή κάλυψης των Basestations(Εικόνα 4.14). Και η δεύτερη το 
Effective που υπολογίζει το uplink load factor(Εικόνα 4.15). 
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Επιλέγοντας φέρουσα συχνότητα(Carrier Frequency:1000) και µπάντα συχνοτήτων(Band Frequency:5) το 
πρόγραµµα υπολογίζει την περιοχή κάλυψης του κάθε σταθµού ξεχωριστά σε χιλιόµετρα. Εµφανίζεται µία 
λίστα µε όλα τα BaseStations και αναλυτικές πληροφορίες σχετικά µε την κάλυψη, την τεχνολογία 
πρόσβασης, καθώς και το πλήθος των χρηστών που εξυπηρετούνται από αυτά. Για παράδειγµα, το 
Basestation1 µε τεχνολογία UMTS που εξυπηρετεί 53 Users, έχει µέγιστη περιοχή κάλυψης 54,134 
χιλιόµετρα.  
 

 
Εικόνα 4.14  Standard mode 
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Η τελευταία εφαρµογή του προγράµµατος(effective) υπολογίζει το uplink για τα UMTS Basestations. 
Επιλέγοντας το effective εµφανίζεται το textbox της εικόνας 4.15. Εισάγουµε το ακριβές ποσοστό των 
υπηρεσιών που χρησιµοποιούν οι χρήστες και στην συνέχεια εµφανίζεται µία λίστα µε τα Basestations, την 
τεχνολογία πρόσβασης που χρησιµοποιεί το κάθε ένα από αυτά, τον αριθµό των Users που εξυπηρετούνται 
από αυτά, την επιστρεφόµενη τιµή uplink load factor για τεχνολογία UMTS για κάθε ένα από αυτά και τέλος 
τα kbps που χρησιµοποιούν οι Users για τις άλλες τεχνολογίες(GSM,WLAN). Για παράδειγµα, το 
Basestation1 µε 53 Users και µε τεχνολογία UMTS, έχει uplink load factor 79,34%. Συνεπώς το Basestation 
1 αγγίζει το 100% των δυνατοτήτων του περισσότερο απο το Basestation 2, που χρησιµοποιεί την ίδια 
τεχνολογία (UMTS), και έχοντας λιγότερους Users στο σύνολό τους 35, έχει uplink load factor µικρότερο 
αγγίζοντας το 51,88%.  

 

 
Εικόνα 4.15  Percentage mode 
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Στις εικόνες 4.16, 4.17, 4.18, 4.19 παρουσιάζεται η διαδικασία κατά την οποία αποθηκεύουµε(File->Save 
As) τα αποτελέσµατα από τις εφαρµογές της πλατφόρµας(max,Effective,Normilize) σε excel αρχεία για 
καλύτερη παρουσίαση και παρατηρησή τους βοηθώντας µας να αποκοµίσουµε ασφαλέστερα 
συµπεράσµατα. 

 
 

 
Εικόνα 4.16  File->Save As 

 
 
 

 
Εικόνα 4.17  File Operation 
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Εικόνα 4.18 Base Stations(coverage) Office file 
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Σχήµα 4.1 Basestations Coverage diagram 

 
 

Στο Σχήµα 4.1 βλέπουµε µε γραφικό τα αποτελέσµατα της εφαρµογής Max του προγράµµατος, που 
παρουσιάστηκαν παραπάνω στο excel αρχείο, δηλαδή την περιοχή κάλυψης σε χιλιόµετρα για κάθε ένα απο 
τους 15 BaseStations του υλοποιηµένου µας δικτύου, καθώς και το πλήθος των χρηστών που έχουν συνδεθεί 
σε αυτους, επιτρεποντάς µας να παρατηρήσουµε εύκολα, ποιός είναι ο BaseStation µε την µεγαλύτερη 
κάλυψη. Το γραφικό αυτό αποδεικνύει µε τον πιό εύγλωττο τρόπο, ότι για την µέγιστη περιοχή καλύψης του 
σταθµού δεν παίζει ρόλο το πλήθος των χρηστών που εξυπηρετεί, αλλά οι θεσείς τους. 
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Εικόνα 4.19  Base Stations(uplink) Office file 
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Σχήµα 4.2 Basestations Uplink diagram 

 
 

Στο Σχήµα 4.2 βλέπουµε µε γραφικό τα αποτελέσµατα της εφαρµογής Effective του προγράµµατος, που 
παρουσιάστηκαν παραπάνω στο excel αρχείο, δηλαδή το uplink load factor σε % ποσοστό για κάθε ένα απο 
τους 15 BaseStations του υλοποιηµένου µας δικτύου, καθώς και το πλήθος των χρηστών που 
εξυπηρετούνται από αυτούς επιτρεποντάς µας να παρατηρήσουµε εύκολα ποιός είναι ο BaseStation που 
πλησιάζει περισσότερο από τους άλλους το 100% της χρησιµοποίησης του. Παρατηρούµε ότι το 
αποτέλεσµα αυτό είναι άµεσα εξαρτώµενο από το πλήθος των χρηστών. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Πτυχιακή Εργασία Τµήµατος Εφαρµοσµένης Πληροφορικής & Πολυµέσων 

                                                                                                                                                            46 

Τέλος ο χρήστης του προγράµµατος έχει την δυνατότητα να εκτελέσει δεύτερο(Εικόνα 4.21) και τρίτο 
σενάριο(Εικόνα 4.23) αν το επιθυµεί, µε διαφορετικό πλήθος χρηστών και συντεταγµένες, παραµένοντας 
όµως οι σταθµοί σταθεροί στις αρχικές τους θέσεις. Αυτή η δυνατότητα αποδεικνύει µεταξύ άλλων, οτι 
πρόκειται για Cognitive Radio προσοµοιωτή δικτύου, καθώς µε την αλλαγή των συνθηκών που επικρατούν 
µια δεδοµένη στιγµή και την διαφοροποίηση των τιµών, αναγκάζει τους σταθµούς να µεταβάλλουν τα 
χαρακτηριστικά τους για να ανταπεξέλθουν στις νέες συνθήκες. Αυτό αποτελεί και το κυριότερο 
χαρακτηριστικό της γνωστικής τεχνολογίας.  
Στις εικόνες παρακάτω παρουσιάζεται η διαδικασία εκτέλεσης του δεύτερου σεναρίου µε συνολικό πλήθος 
επτακοσίων χρηστών. 

 

 
Εικόνα 4.20  Data->User's scenario's 2 

 

 
 

Εικόνα 4.21  User's Scenario's 2 
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Στις εικόνες παρακάτω παρουσιάζεται η διαδικασία εκτέλεσης του τρίτου σεναρίου µε συνολικό πλήθος 
οκτακοσίων πενήντα χρηστών. 

 
Εικόνα 4.22  Data->User's Scenario's 3 

 

 
 

Εικόνα 4.23 User's Scenario's 3 
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4.4 Συµπεράσµατα 
Το Cognitive Radio µπορεί να µην είναι διαδεδοµένο αυτή τη στιγµή, όµως είναι µια νέα τάση η οποία πολύ 
πιθανόν στο µέλλον να αποτελέσει την κυρίαρχη τεχνολογία στα ασύρµατα δίκτυα. Είναι ακόµα µια νέα 
τεχνολογία και θα πρέπει να ξεπεραστούν αρκετά εµπόδια µέχρι να µπορέσει να εξαπλωθεί εµπορικά.  
Θα πρέπει κατ’αρχάς να ξεπεραστεί η δυσπιστία του εµπορικού κόσµου, που είναι λογικό να µην υιοθετεί 
εύκολα µία νέα τεχνολογία την οποία δεν γνωρίζει. Για αυτό τον λόγο, θα πρέπει οι ερευνητές, που είναι 
εξειδικευµένοι στην cognitive radio τεχνολογία, να σχεδιάσουν υλικό(hardware) και λογισµικό(software) για 
CR πλατφόρµες καθώς επίσης και να αναπτύξουν αλγόριθµους και πρωτόκολλα για γνωστικά συστήµατα 
ραδιοεπικοινωνιών. 
Εν συνεχεία, προβάλλοντας τα πλεονεκτήµατα αυτής της τεχνολογίας και έχοντας φτάσει η συµφόρηση του 
φάσµατος σε τόσο υψηλά επίπεδα που πολλοί χρήστες δεν θα είναι σε θέση να καλύψουν τις ανάγκες τους 
είναι βέβαιο ότι θα πεισθούν και οι πλέον δύσπιστοι και θα στραφούν στην cognitive radio τεχνολογία. 

4.5 Μελλοντική ανάπτυξη 
Μελλοντικά, θα ήταν χρήσιµη η ανάπτυξη µίας εφαρµογής της πλατφόρµας CR η οποία θα επέτρεπε στον 
χρήστη, να δέχεται την ακριβή θέση των users µέσω ενσωµατωµένων GPS στις τερµατικές τους συσκευές. 
Με αυτόν τον τρόπο ο χρήστης της πλατφόρµας θα µπορεί να εισάγει τα δεδοµένα που θα του στέλνουνε οι 
users(συντεταγµένες θέσης, τιµή προσφοράς, κ.τ.λ.) πιό εύκολα και γρήγορα αναπαραστώντας αληθοφανή 
δίκτυα, πάνω σε πραγµατικούς χάρτες(π.χ. Google Earth) η προσοµοίωση των οποίων θα είναι απολύτως 
χρήσιµη σε παρόχους δικτύων τηλεπικοινωνιών.   
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